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1. Introduction 

Welcome to HistCite. 

This chapter will give you some basic information you need before you start using HistCite. 

     What is HistCite?(See 1.1) 

     What can I do with HistCite?(See 1.2) 

     System Requirements(See 1.3) 

     Web of Science(See 1.4) 

 

 

 

Version 2009.08.24 

1.1 What is HistCite? 

HistCite® is a flexible software solution to aid researchers in visualizing the 

results of literature searches in the Web of Science. It is easy, fast, and provides 

perspectives and information not available from Web of Science(See 1.4). 

HistCite creates clear and informative data tables and graphs in an HTML 

format readable in a web browser. Go here to see examples of HistCite HTML 

output. 

HistCite is a software implementation of algorithmic historiography, and is developed by Dr 

Eugene Garfield, founder of the Institute for Scientific Information and the inventor of 

historiographic citation analysis. Go here for a bibliography of papers on algorithmic 

historiography. 

1.2 What can I do with HistCite? 

Identify the key literature in a research field 

    identify papers important to the development of the topic  

    pinpoint important papers "missed" by a keyword search  

    identify the most prolific and most cited authors and journals in a field 

    identify other keywords that can be used to expand the collection  

Reconstruct the history and development of a research field 

    create historiographs showing the key papers and time line of a research 

field.  

    creating historiographs for individual authors 

http://garfield.library.upenn.edu/histcomp/
http://garfield.library.upenn.edu/histcomp/
http://garfield.library.upenn.edu/
http://garfield.library.upenn.edu/
http://garfield.library.upenn.edu/algorithmichistoriographyhistcite.html
http://garfield.library.upenn.edu/algorithmichistoriographyhistcite.html
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    find highly cited articles  

    discover important co-author relationships  

    locate earlier publications and documents important to the development of an 

author’s work 

    develop a time line of an authors’ publications 

Analyze publication productivity and citation rates within a collection of 

research papers 

Compare characteristics such as: 

    countries and institutions that authors publish from  

    most prolific and most cited authors within groups  

    citation statistics for groups and subgroups (mean and median citation rates of 

papers, number of authors per paper, etc.) 

    compute author h-Index, both including and excluding self-citations. 

1.3 System Requirements 

HistCite runs on Windows-based PC's only. 

HistCite itself requires a small amount of disk space and memory. The amount of disk space 

and memory required is dependent on the size of the collections you plan to analyze. 

For example, a Web of Science file with 2,500 records takes about 10 MBytes of disk space. 

When open in HistCite, it uses 80 MBytes of RAM. 

HistCite requires Internet Explorer version 8, 7 or 6. It has been fully tested with these 

browsers. It will work with other browsers (Firefox, Opera) but has not been fully tested. 

1.4 Web of Science 

In order to use HistCite effectively, you will need access to Web of Science. 

Web of Science is a database published by Thomson Reuters as part of their Web of 

Knowledge series of products. HistCite performs its analyses on the results of searches of 

Web of Science which are exported to text files. 

Check with your library to ensure that you have access to Web of Science. 

Full details are available at http://www.isiwebofknowledge.com/ 

2. Getting Started 

This chapter will lead you through the basic steps required to get you started using HistCite. 

If you follow along using the Sample Data File provided, you will learn many of the essential 

features of the software. 

    Downloading Data from Web of Science(See 2.1) 

http://www.isiwebofknowledge.com/
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    Sample Data File(See 2.2) 

    Importing data into HistCite(See 2.3) 

    List of All Records(See 2.4) 

    Navigation(See 2.5) 

    Historiographs(See 2.6) 

    Displaying and Sharing HistCite Analyses(See 2.7) 

Later chapters will provide detailed descriptions of all the functions and features available. 

2.1 Downloading Data from Web of Science 

HistCite does its analyses on text files of search results downloaded from Web of Science, 

the database published by Thomson Reuters. 

Follow these steps to download a file you want to analyse. 

1.         Carry out a search on Web of Science:  

This Help file is not the place to give a full tutorial on WoS searching. Check with your 

librarian or on the Thomson Reuters web site for more information on Web of Science 

searches. Here are the minimal steps you will require. 

1.   Log in to Web of Knowledge with your personal or institutional user name and password (if 

required). 

2.   Navigate to Web of Science "Search" page. 

3.   Enter your search terms, define your search fields and click "Search". 

4.   The system will carry out the search and display the Search Results. Refine your search as 

necessary. 

2.         Download results to a text file 

1.   Once you have a set of search results that you want, you can export them to a text file. Scroll 

to the bottom of the page to the section marked "Output Records". 

2.   In "Step 1:", select the radio button next to "Records [  ] to [  ]" . 

Remember that WoS allows only 500 records to be exported at a time, so if you want to 

analyse more than 500 records you will need to do them in batches, e.g. 1 - 500, 501 - 1000, 

etc. 

3.   In "Step 2:", select the radio button for "Full Record" and the check box marked "plus Cited 

References". 

4.   In "Step 3:", Choose " - as Plain Text" from the "Save To..." pull-down menu, and click 

"Save". 

5.   The system will prepare a text file and eventually show a page with a "Save" button. Save 

the file with an appropriate name in a location where you can find it later. 

The records saved this way will be complete records including abstracts and e-mails. If you 

do not need such complete records you can export data from a Web of Science "Marked List", 

which gives you greater control of the export content. See below for details. 

Export Data from a Marked List 

1.   Carry out steps 1 - 4 from section 1 above.  

2.   Add individual records to a Marked list by checking the box or boxes next to 

a record or multiple records and clicking on "Add to Marked List". 

http://www.isiwebofknowledge.com/
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OR 

Scroll to the bottom of the page to the section marked "Output Records". In 

"Step 1:", select the radio button next to "Records [  ] to [  ]" . Enter the record 

numbers you need. (Don't forget the 500 record limit on exports). In Step 3 click 

on ""Add to Marked List". 

3.   Once you have added all the records you want to the Marked List in Web of 

Science, you are ready to export the Marked List to a text file. Click on the 

"Marked List" button at the top of the page in WoS. 

4.   In "Step 1" select the following fields for export: 

    Author 

    Title 

    Source 

    Language 

    Document Type 

    Addresses 

    Cited References 

    Cited Reference Count 

    Times Cited 

You may also export the Abstract and E-mail address fields, though this will slow 

down the export. These fields are stored by HistCite but not used in its analyses. 

5.   In "Step 2" Select the "Field Tagged" option beside the "Save to File" button 

then click on the "Save to File" button.  

6.   The system will prepare a text file and eventually show a page with a "Save" 

button. Save the file with an appropriate name in a location where you can find it 

later. 

Next Step: Sample Data File(See 2.2) 

2.2 Sample Data File 

In order to get you started quickly and easily with HistCite, we provide a 500 record file 

exported from Web of Science that will allow you to practice using the various functions of 

HistCite. 

All the following steps in the "Getting Started" section of this Help system refer to the sample 

file we have provided, called "HistCiteSample.txt". This file was created by searching for the 

phrase "Citation analysis" in Web of Science. Instructions and descriptions specific to the 

use of the sample file are shown in red. 

Once a text file has been opened by HistCite and saved, it is changed to a HistCite file with 

extension .hci. 

Next Step: Importing data into HistCite(See 2.3) 
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2.3 Importing data into HistCite 

There are three principal ways of starting a HistCite analysis 

Start Application 

1.   Start the HistCite application by double clicking on the HistCite icon on your desktop or 

select HistCite from the "Start > All Programs" menu. 

2.   HistCite starts up, first by opening a (black) command window, then by interfacing with 

Internet Explorer. Internet Explorer provides the user interface through which the user 

interacts with the HistCite program. HistCite opens to an "empty" page. 

3.   From the "File" menu, click on "Add File...", then click the Browse button and locate a Web of 

Science export file (with .txt extension) or a HistCite file (with .hci) extension) in the open file 

dialog. Once you have located the correct file, click "Open" then "Add File"  

Drag and Drop 

1.   From Windows Explorer, locate the text file or files that you want to analyze. 

2.   Drag and drop the files on to the HistCite application file icon, HistCite.exe. This is located 

where the installer placed it (usually C:\Program Files\HistCite). Alternatively drop the files 

onto the shortcut on the Windows Desktop. It is possible to select multiple files and drag and 

drop them on to the icon simultaneously.  

Drag and drop the file called "HistCiteSample.txt" onto the HistCite icon. 

Please note that HistCite only imports unique WoS records for analysis.  For a detailed 

report of your import, from the "Tools" menu click on "Logs..." 

 

Open a HistCite Data File 

1.   Double-click on a previously saved HistCite file (extension .hci). 

Once you have activated the analysis you will first see a screen showing the analytical 

activities which HistCite is carrying out. Analysis will take from a few seconds to several 

minutes, depending on the size of your file(s), the speed of your computer, and the amount of 

free memory. 

Note: Do not close the black command window while you are using HistCite. If you do, 

HistCite will cease to function though you will still see data in the browser window.   

Next Step: List of All Records(See 2.4) 

2.4 List of All Records 

When HistCite first opens, it shows the main page where all the records in your collection are 

listed. 

On first starting HistCite, the All Records list is overlaid with the "HistCite Tip of the Day" 

window, where useful tips and hints are displayed.  

Close the "Tips" window to view the List of All Records. 
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The main items to notice on the opening page areas follows: 

Window Title Bar: Shows the currently open primary file. 

Menu Bar: Contains all the controls and functions you will need when using HistCite. 

Collection title and description: This is a title and description of the collection that you can 

add, using the File ->Properties... dialog, or click on the title to edit. The default is "Untitled 

Collection"  

Collection Statistics: This shows the Grand Totals of local and global citation scores and 

the number of citations of all the papers in the collection. Below this is the date range of the 

papers in the collection. 

Analyses Index(See 3.): The top line of the Analyses Index shows the parameters of the 

collection, and allows access to specific analyses. The sample file has 500 records written 

by 756 unique authors, published in 202 journals, with 14,088 cited references, and 1,215 

unique title words.  

The second line of the analyses index shows a series of links to specific analyses. 

Click on any of the links in the Analyses Index to see the data analyzed by that parameter. 

In the default view the Analyses index is shown. If it is not showing, go to Tools -> Analyses 

Index to switch it on. 

Navigation controls: Immediately above and below the main table are the navigation 

controls which allow you to rapidly move through the collection. See the Navigation(See 2.5) 

section for more details. 

The record table: When you first open a collection in HistCite the main table shows the 

records sorted by date order. The main table column headings are described below. Click on 
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any of the blue or purple table headings to sort the table by that data. The current sort 

parameter and all relevant sorted data is highlighted in purple. Clicking a second time on a 

purple heading will reverse the sort order. 

#: Table row number. This varies dynamically and depends on the sort order. 

Date/Author/Journal: This column contains the full record of each paper in the 

collection.  Click on the Date or Author or Journal column heading to sort the records by 

these parameters. In Date sort order (the default) the table displays cross-headings for each 

year represented in the collection. 

LCS: Local Citation Score: Number of citations to the paper from within the collection. 

GCS: Global Citation Score: Number of citations to the paper from all sources, as reported in 

Web of Science when the data was downloaded. 

LCR: Local Cited References: Number of records in the collection that are cited by the paper. 

This number is an indication of the relevance of the paper to the collection. 

CR: Number of Cited References: Total number of cited references in the bibliography of the 

paper. 

Records: Each record shows the data for a member of the collection in the standard 

Vancouver style. Each record is assigned a record number by HistCite. 

Records contain several hot links which lead to filtered lists. Hot links in records will turn blue 

and underlined when hovered over. In addition, a small "tool tip" window will appear 

indicating the number of records in the filtered list and the TLCS and TGCS scores.  

Click on... 

LCR - to show a filtered list of papers in the collection that are cited by the record. 

Record number - to open the detailed record of the paper, and to edit the record. (See 

Editing individual records(See 6.1)). 

Author name - to show a filtered list of papers written by that author. 

Words in article title - to show a filtered list of papers in the collection with that title word. 

Journal title - to show a filtered list of papers published in that journal. 

Publication year - to show a filtered list of papers published in that year. 

LCS - to show a filtered list of papers in the collection that cite the record. 

 

Next Step: Navigation(See 2.5) 

2.5 Navigation 

All record and analytical lists in HistCite have navigation controls and an optional page index. 

Navigation Bar 

By default the Navigation Bar is switched on. 

 

The navigation bar controls operate as follows: 

|<         moves to start of current list 

<<       moves back 100 items 

<          moves back 10 items 

>          moves forward 10 items 
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>>       moves forward 100 items 

>|         moves to end of current list 

The number of items moved by the double arrow controls (<< and >>) can be altered by 

changing the Record List page size in the Settings...(See 7.4.8) dialog. 

Regular Page Index 

By default the Page Index is switched off. 

 

The regular page index shows all the pages of the current view of the collection. Click on a 

page number to move to that page.  

Display of the page index can be switched on and off in the Settings...(See 7.4.8) dialog.  

Extended Page Index 

By default the Extended Page Index is switched off. 

 
The extended page index, in addition to the page number shows the first item on the page 

according to the current sort. The example above shows the extended page index of the 

author list sorted by author name. 

Display of the extended page index can be switched on and off in the Settings...(See 7.4.8) 

dialog.  

 

Next step: Historiographs(See 2.6) 

2.6 Historiographs 

One of the key features of HistCite is the ability to create historiographs -- graphs showing 

the time line of publications in a collection, with arrows indicating the citation links. 

From the menu bar, select Tools ->Graph Maker. Click on "Make Graph" to create a 

historiograph of the collection. 

Click on "Make graph" to see the default historiograph of the collection. Hover over a node to 

see summary information and click on a node for a detailed record. 

Go to "Graph Maker(See 4.)" for complete details on using this powerful tool. 

Next Step: Displaying and Sharing HistCite Analyses(See 2.7) 

2.7 Displaying and Sharing HistCite Analyses 

There are a number of ways that analyses and graphs produced by HistCite can be 

displayed and shared. These are listed here and described in detail in other parts of this Help 

documentation. 

    Any table may be printed out as it appears in the software. (See "Print...(See 7.1.8)") 

    All tables can be exported as CSV (comma separated value) text files, which can then be 

imported into a spreadsheet, word processing program or database for further analysis, 

editing and presentation. (See "Export(See 7.1.6)") 
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    Historiographs may be printed out directly from Graph Maker. This produces lower quality 

prints.  (See "Graph Maker(See 4.)") 

    Historiographs may be saved as Postscript files, which can then be imported into 

presentation programs (e.g. Powerpoint), word processors (e.g. Microsoft Word), graphics 

programs (e.g. Adobe Illustrator and Adobe Photoshop), or converted to PDF files. This 

yields the highest quality graphics and prints. (See "Graph Maker(See 4.)") 

    The entire dataset with graphs and tables can be exported as a set of HTML documents that 

can be published on a web site for display and exploration. (See "HTML Presentations(See 

5.)") 

3. Analyses Index 

The top line of the Analyses Index shows the parameters of the collection, and allows access 

pages with compiled data in various categories.  

    Records(See 3.1) 

    Authors(See 3.2) 

    Journals(See 3.3) 

    Cited References(See 3.4) 

    Words(See 3.5) 

    Tags(See 3.6) (Only visible when there are tagged records in the collection) 

    Marks(See 3.7) (Only visible when there are marked records in the collection) 

The second line of the Analyses Index shows links to additional analyses.  

    Yearly output(See 3.8) 

    Document Type(See 3.9) 

    Language(See 3.10) 

    Institution(See 3.11) 

    Institution with Subdivision(See 3.12) 

    Country(See 3.13) 

The Analyses Index is shown by default. If it is not showing, select Tools -> Analyses Index 

from the menu bar to switch in on. 

3.1 Records 

The first item in the Analyses Index is Records, followed by the number of records in the 

collection. 

 

From any screen click on the word Records in the Analyses Index to return to the List of All 

Records(See 2.4). 

 

This table is described in detail in the "Getting Started" section: List of All Records(See 2.4). 
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3.2 Authors 

The Authors page shows a list of all the authors of papers in the collection. 

 

The default view is sorted in descending order of papers per author. 

Remember: You can click on any column header to sort by that parameter or to change sort 

order from ascending to descending. 

Table Headings 

#: Rank based on the current sort order. 

Author: Author Name. 

Recs: Number of papers (records) by the author in the collection. Click on this number to see 

a filtered list of records of papers by the author. 

TLCS: Total Local Citation Score = Total citations in the collection to the author. 

TGCS: Total Global Citation Score = Total citations in Web of Science to papers by the 

author in the collection. (Note that this is not necessarily the total citations to an author in 

Web of Science; only to those papers by the author included in the collection). 

Hover over any value in the table to see the percentage of the total. E.g. Hover over the 

number of papers to see what percentage it represents of all papers in the collection.  
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3.3 Journals 

The Journals page shows a list of all the journals listed in the collection. 

 

The default view is sorted in descending order of papers per journal. 

Remember: You can click on any column header to sort by that parameter or to change sort 

order from ascending to descending. 

Table Headings 

#: Rank based on the current sort order. 

Journal: Journal Title. 

Recs: Number of papers (records) published in the journal in the collection. Click on this 

number to see a filtered list of papers published in the journal. 

TLCS: Total Local Citation Score = Total citations in the collection to the journal. 

TGCS: Total Global Citation Score = Total citations in Web of Science to papers in the journal 

in the collection. (Note that this is not necessarily the total citations to the journal in Web of 

Science; only to those papers in the journal included in the collection) 

Hover over any value in the table to see the percentage of the total. E.g. Hover over the 

number of papers to see what percentage it represents of all papers in the collection. 

3.4 Cited References 

This page shows all the references cited in the collection. It is valuable for showing the most 
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cited papers in a collection, and for identifying papers that are cited by papers in the 

collection but were not included in the collection.  

 

Records in blue are part of the collection. Records in black are not part of the collection as 

they did not meet Web of Science search criteria, or they are not indexed in Web of Science. 

In the HistCite Sample File provided with the program, cited reference 1 is to a 

book (Garfield E, 1979, Citation Indexing), which is not indexed in Web of 

Science. Item 4 is a paper (SMALL H, 1973, J AM SOC INFORM SCI, V24, 

P265) which does not include the words "Citation Analysis" in the title. The 

paper is cited 46 times in this collection so it is obviously very relevant to the 

topic even though it was "missed" by the search. 

In the default view, the records are sorted by the number of times cited. 

Remember: You can click on any column header to sort by that parameter or to change sort 

order from ascending to descending. 

Table Contents 

#: Rank based on the current sort order. 

Author / Year / Journal: Shows the reference as it appears in the bibliographies of the 

records. References in blue are to papers included in the collection. Click on the reference to 

go to detailed record. Click on the table headings to sort the table by Author, Year, or Journal 

+ / WoS: The "Make Record" link (available only on references in black that are not in the 
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collection) allows the user to turn a reference into a record in the collection. (See "Adding 

records manually(See 6.2)" in the "Editing your collection" section). The "WoS" link will 

automatically search Web of Science for the cited reference. (See "Adding records from the 

Cited Reference list(See 6.4)" in the "Editing your collection" section.) 

Recs: Shows the number of records in which this reference is cited. Click on the number for 

a filtered list of the records which cite this reference. 

3.5 Words 

This page shows an analysis of words that occur in the titles and keyword lists of the papers 

in collection. 

The Word list analysis has a number of user settings that are controlled by the Settings menu. 

Go to the Settings...(See 7.4.8) dialog Help for a more detailed discussion. 

The following settings are the defaults. All of them can be changed in the Settings...(See 7.4.8) 

dialog: 

    Title words are included.  

    Stop Words(See 8.1) and words of 2 characters or fewer are excluded.  

    The parts of a hyphenated word are treated as separate words. 

    Author Keywords, included in recent Web of Science records, are excluded. 

    Web of Science Keywords Plus are excluded. KeyWords Plus® are index terms created by 

Thomson Reuters from significant, frequently occurring words in the titles of an article's cited 

references, and are found in more recent WoS records. 

Author keywords and Web of Science Keywords Plus may be included by changing the 

Settings. In addition, choices can be made to split multiword terms and hyphenated terms. 

Keywords may be identified by type style. The following example shows a word list with 

author and WoS Keywords Plus included.  Words in italics are found in the keyword lists, but 

not in titles. Words in bold italics are found in both title and keyword lists. 
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The default view is sorted in descending order of word frequency appearance. 

Remember: You can click on any column header to sort by that parameter or to change sort 

order from ascending to descending. 

Table Headings 

#: Rank based on the current sort order. 

Word 

Recs: Number of papers (records) in the collection with this title word. Click on this number 

to see a filtered list of records of papers with this word in the title. 

TLCS: Total Local Citation Score = Total citations in the collection to papers with the word in 

the title 

TGCS: Total Global Citation Score = Total citations in Web of Science to papers in the 

collection with the word in the title. (Note that this will not be the total citations to this title 

word in Web of Science; only to those papers with this title word included in the collection) 

Hover over any value in the table to see the percentage of the total. E.g. Hover over the 

number of papers to see what percentage it represents of all papers in the collection. 
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3.6 Tags 

This page shows the list of tags attached to the records in the collection. Tags are custom 

labels that can be attached to records by the user. 

When a new collection is opened, all the records by default are untagged and "Tags" does 

not appear in the Analyses Index. When a tag is added to any records in the collection, all 

untagged records are automatically tagged with "Other". 

See "Mark & Tag(See 7.4.5)" for a detailed explanation of record tagging. 

Table Headings 

#: Rank based on the current sort order. 

Tag: Tag name and description (assigned by user) 

Recs: Number of papers (records) in the collection with this tag. Click on this number to see 

a filtered list of records of papers with this tag assigned. 

TLCS: Total Local Citation Score = Total citations in the collection to papers with the tag. 

TGCS: Total Global Citation Score = Total citations in Web of Science to papers in the 

collection with the tag. 

Hover over any value in the table to see the percentage of the total. E.g. Hover over the 

number of papers to see what percentage it represents of all papers in the collection. 

3.7 Marks 

"Marks" only appears in the Analyses Index if there are marked records in the collection. The 

number after the word "marks" indicates the number of marked records. 

Go to "Mark & Tag(See 7.4.5)" for a complete explanation of how to mark records. 

The table columns and functions are the same as those on the Records List page. 

3.8 Yearly output 

The Yearly Output page shows the collection analyzed by publication year. 

The default view is sorted in ascending order of year. 

Remember: You can click on any column header to sort by that parameter or to change sort 

order from ascending to descending. 

Table Headings 

#: Rank based on the current sort order. 

Publication Year: List of publication years represented in the collection. 

Recs: Number of papers (records) published in the year in the collection. Click on this 

number to see a filtered list of papers published in the year. 

TLCS: Total Local Citation Score = Total citations in the collection to the articles published in 

that year. 

TGCS: Total Global Citation Score = Total citations in Web of Science to papers published 

that year in the collection. 

Click on "Histogram" in the page heading for a graphic display of publication year 
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distribution.  

Hover over any value in the table to see the percentage of the total. E.g. Hover over the 

number of papers to see what percentage it represents of all papers in the collection. 

3.9 Document Type 

The Document Type page shows the collection analyzed by document type, as assigned in 

Web of Science.  

The default view is sorted in descending order of papers per document type. 

Remember: You can click on any column header to sort by that parameter or to change sort 

order from ascending to descending. 

Table Headings 

#: Rank based on the current sort order. 

Document Type: List of document types represented in the collection. 

Recs: Number of papers (records) of that type in the collection. Click on this number to see a 

filtered list of papers of that document type. 

TLCS: Total Local Citation Score = Total citations in the collection to articles of that 

document type. 

TGCS: Total Global Citation Score = Total citations in Web of Science to papers of that 

document type in the collection. 

Hover over any value in the table to see the percentage of the total. E.g. Hover over the 

number of papers to see what percentage it represents of all papers in the collection. 

3.10 Language 

The Language page shows the collection analyzed by language, as assigned in Web of 

Science.  

The default view is sorted in descending order of papers per language. 

Remember: You can click on any column header to sort by that parameter or to change sort 

order from ascending to descending. 

Table Headings 

#: Rank based on the current sort order. 

Language: List of languages represented in the collection. 

Recs: Number of papers (records) in that language in the collection. Click on this number to 

see a filtered list of papers in that language. 

TLCS: Total Local Citation Score = Total citations in the collection to articles in that language. 

TGCS: Total Global Citation Score = Total citations in Web of Science to papers in that 

language in the collection. 

Hover over any value in the table to see the percentage of the total. E.g. Hover over the 

number of papers to see what percentage it represents of all papers in the collection. 
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3.11 Institution 

The Institution page shows the collection analyzed by institution, as entered in the address 

field of the records in Web of Science.  

The default view is sorted in descending order of frequency of institution names. 

Remember: You can click on any column header to sort by that parameter or to change sort 

order from ascending to descending. 

Table Headings 

#: Rank based on the current sort order. 

Institution: List of institutions represented in the collection. 

Recs: Number of papers (records)from that institution in the collection. Click on this number 

to see a filtered list of papers from that institution . 

TLCS: Total Local Citation Score = Total citations in the collection to articles from that 

institution. 

TGCS: Total Global Citation Score = Total citations in Web of Science to papers from that 

institution in the collection. 

Hover over any value in the table to see the percentage of the total. E.g. Hover over the 

number of papers to see what percentage it represents of all papers in the collection. 

Note that variations in data entry, in abbreviations, and among journals means 

that there may be several variants of the same institution name in a collection. 

For example, click on the heading "Institution". Items 10 and 11 in the list are 

"ARIZONA STATE UNIV" and "Arizona State Univ W". You can unify these two 

variants using the Edit Tool. See "Editing data with the Edit Tool(See 6.3)" for 

details. 

3.12 Institution with Subdivision 

The Institution with Subdivision page shows the collection analyzed by institution with 

subdivision -- usually a department or division within the institution, as entered in the address 

field of the records in Web of Science.  

The default view is sorted in descending order of frequency of institution with subdivision 

names. 

Remember: You can click on any column header to sort by that parameter or to change sort 

order from ascending to descending. 

Note that variations in data entry, in abbreviations, and among journals means that there 

may be several variants of the same institution and subdivision name in a collection.  

Table Headings 

#: Rank based on the current sort order. 

Institution with subdivision: List of institutions with subdivisions represented in the 

collection. 

Recs: Number of papers (records)from that institution subdivision in the collection. Click on 

this number to see a filtered list of papers from that institution subdivision. 
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TLCS: Total Local Citation Score = Total citations in the collection to articles from that 

institution subdivision. 

TGCS: Total Global Citation Score = Total citations in Web of Science to papers from that 

institution subdivision in the collection. 

Hover over any value in the table to see the percentage of the total. E.g. Hover over the 

number of papers to see what percentage it represents of all papers in the collection. 

3.13 Country 

The Country page shows the collection analyzed by country, as entered in the address field 

of the records in Web of Science.  

The default view is sorted in descending order of frequency of records per country. 

Remember: You can click on any column header to sort by that parameter or to change sort 

order from ascending to descending. 

Table Headings 

#: Rank based on the current sort order. 

Country: List of countries represented in the collection. 

Recs: Number of papers (records) from that country in the collection. Click on this number to 

see a filtered list of papers from that country. 

TLCS: Total Local Citation Score = Total citations in the collection to articles from that 

country. 

TGCS: Total Global Citation Score = Total citations in Web of Science to papers from that 

country in the collection. 

Hover over any value in the table to see the percentage of the total. E.g. Hover over the 

number of papers to see what percentage it represents of all papers in the collection. 

 

See Also: 

Country Lists(See 8.3) 

Country List Settings(See 7.4.8) 

4. Graph Maker 

The HistCite Graph Maker allows the user to create "historiographs" of the papers in the 

collection. A historiograph is a chronological citation network showing citation links between 

papers. 

The Graph Maker allows the user to alter many parameters of the graphs, and to export and 

print the results. 

The best way to learn Graph Maker is to use it and to experiment with various settings. To get 

started, open Graph Maker in the Tools menu and click "Make graph". Default settings will 

usually generate a graph that fits onto one screen or one printed page. 

The topics in this chapter describe the functions of Graph Maker in detail. 

    Graph Maker Overview(See 4.1) 
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    Graph Maker Menu(See 4.2) 

    Graph Output(See 4.3) 

4.1 Graph Maker Overview 

The following is the default graph generated by Graph Maker from the HistCite Sample File. 

 

Overview 

The Graph Maker window is divided into two main parts. On the left there is a menu with a 

set of parameters that can be changed (See "Graph Maker Menu(See 4.2)"). To the right is the 

area where data are presented. When a graph is created, this area is divided into graphical 

and text panes. The separator between the two is movable. The graph area has links at the 

top which control output (See "Graph Output(See 4.3)").  

The vertical axis of the graph represents time. Nodes are placed on the horizontal axis for 

optimal visual presentation. Each node in a graph represents a record. The numbers on the 

graph relate to the record numbers in the list below. You can also hover over a node to see 
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abbreviated record data, and click on a node to bring up the detailed record . In default mode, 

the size of a node is proportional to the Local Citation Score. 

4.2 Graph Maker Menu 

The main Graph Maker menu panel on the left is divided into several sections with different 

types of controls. Click on the + and - signs to hide and show the controls under that heading. 

The following are detailed explanations of the parameters that control the presentation of a 

graph. Whenever a parameter is changed, click on "Make graph" to see the result. 

Select by 

Use these criteria to select records to include in a graph. For example:  

    'LCS count limit: 30' will select top 30 records from the collection sorted by LCS. This is 

usually the best way to show the most important citation links within the collection. 

    'GCS value limit: 500' will select records with GCS equal to or greater than 500.  

If your collection has marked records, they can be included for the graph, in addition to the 

above selection criteria or exclusively. Using marked records gives more flexibility because 

selection criteria in the "Mark & Tag(See 7.4.5)" tool are more comprehensive.  

Generally, a network of up to 50 nodes can easily fit onto a screen or one printed page. This 

number will greatly depend on the density of citation links, ratio of nodes with high citation 

scores, placement of node numbers, etc. Adjust the parameters below appropriately to make 

the best looking picture.  

Node 

Use these controls to set the appearance of the nodes in the graph 

    Select node shape -- circle or square, or no node boundary.  

    Select node size criteria. 

Use 'Scale' to draw nodes proportional to LCS or GCS (depending on selection criteria) 

Use 'Fixed' to make all nodes the same size, and set the node size (from 0.1 inches up to 2 

inches) 

Node distance 

These two parameters control the minimal distance between the nodes. Other factors may 

also affect the actual placement of nodes.  

    Y axis setting, in essence, controls the distance between years. It may be thought of as 

vertical stretch or zoom. 

     X axis sets the distance between nodes in the same year. It may be thought of as horizontal 

stretch or zoom. 

Id placement 

ID (record number) may be placed 'inside' or 'outside' of the node shape, or not shown at all. 

Expanded info about the node is always displayed when a mouse pointer is paused over a 

node.  

When ID is placed 'outside' of the node, 'Proximity' controls how close to the node it should 

be. This is a relative value, starting from 0.  

Arrowhead 

Arrowhead controls allow you to control the appearance of the arrows between nodes, for 

visual effect. 
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    There are two choices for arrow direction. 'backward' corresponds to citation links, 'forward' 

reflects the development progress.  

    There are three arrowhead 'Shapes' available. It is easy to try them all to see which one 

works best. To display no arrowhead, select 'none'.  

    The 'Size' control changes the arrowhead size in relative units.  

Font sizes 

Set font sizes for node numbers, years, and months (when selected).  

Display 

Display controls various other aspects of the graph appearance. 

    Draw links - check this to show the citation links between nodes. With this control unchecked, 

the nodes are organized by time, but unlinked. 

    Merge links - check this control to show multiple links to a node as branches rather than 

multiple single links. This will reduce the clutter in some graphs.  

    Gap years - some collections have years with no published articles. Check this control to 

include all years in the display.  

    # of records - check to display the total node count for each year.  

    Months - check this control to break down the time line by months. This is valuable for 

detailed analysis of citation dependencies when actual dates of publication are known. 

    Info - check to display a summary for the graph, including selection criteria, in the text pane.  

    Legend - check to display details for each node in the text pane..  

'brief' lists the records in an abbreviated one line format 

'full' shows all citation details, including full source name, author list, and publication title.  

When neither 'Info' nor 'Legend' are checked, the text pane is not shown, leaving the entire 

area to the graphical pane.  

    Size - this pulldown menu allows control of the display and output size of the graph. There 

are three choices: 

'window': graph size is fitted to the dimensions of the graphical pane. The exact size is 

approximate and may require re-drawing if the window is resized or the text area is 

enabled/disabled during the process. 

'full' automatically determines the optimum size 

'Letter' fits the output onto one standard Letter page (normally fits A4 format as well). 

Export to file 

Graph data may be saved to a file that can be used by network analysis software or graph 

drawing software. Presently, the following formats are available:  

    Pajek 1 and Pajek 2. Suitable for analysis and further manipulation with Pajek or NetDraw 

network analysis software. Pajek 1 includes detailed node information. Pajek 2 includes 

minimal node information.  

    DOT. Graph description language export, suitable for import into various graphical 

visualization and manipulation tools, e.g. dotty, Graphviz. 

Restore Defaults 

Restores all the parameters to standard values. 

http://vlado.fmf.uni-lj.si/pub/networks/pajek/
http://www.analytictech.com/downloadnd.htm
http://www.graphviz.org/
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4.3 Graph Output 

There are several options for outputting the graphs from HistCite Graph Maker, listed along 

the top of the graph.  

    Print graph - will open a print dialog to send the current graph to a printer. The raster images 

printed from the screen can be poor quality. To produce high quality prints use the PostScript 

link.  

    Print text - will open a print dialog to send the summary and legend to a printer.  

    Keep graph - saves the graph for future reference. Saved graphs can be accessed via Tools 

->Historiographs(See 7.4.2) in the main menu. Saved graphs can also be output in saved 

HTML presentations. A dialog box is provided to set a title and description for the graph.  

    PostScript - saves the file ready for high quality printing or graphical manipulation. Use this 

option if you are preparing a graph for publication or high quality display. Postscript files may 

be opened in a graphics program, printed on a Postscript enabled printer, converted to PDFs, 

imported into Microsoft Powerpoint etc. 

5. HTML Presentations 

HistCite allows the user to export a complete data collection with related analyses and 

graphs as a set of HTML documents suitable for display on a web site, or on another 

computer where the HistCite program is not installed. This is an excellent way to share your 

analysis with others. 

The program can generate every possible screen as a separate HTML file. Depending on the 

size of the collection, this can result in a very large number of files. This number can be 

controlled by HTML Presentation Settings, described below. 

    Choose Export > HTML Presentation from the File menu to start your HTML export. 

    The HTML Presentation Estimate screen will appear showing an estimate of the total 

number of files that will be generated, based on the current Settings. Note that every table, 

every page and every record may be turned into an HTML page, leading to a large number of 

files and significant processing time. 

    Click on Proceed to complete the HTML export process, or on "Settings" to bring up the 

HTML Presentations Settings dialog. Here you can change the parameters of the export. 

The Settings dialog provides various ways to limit the number of files in an HTML 

presentation. Try various settings and see the change in the number of files produced. Don't 

forget -- the larger the number of files, the more disk space required and the longer the 

processing time to create the HTML presentation: 

Apply no limits/Apply the following limits: Select the radio button to produce a full export 

of every table and record in the collection or to activate the limits set in the following. Note 

that setting no limits may result in a very large set of files that is slow to create. 

Include individual record pages for records with these limits LCS >= [nnn] or GCS >= 

[mmm] Fill in values for nnn and mmm to restrict the inclusion in the HTML presentation to 

full record pages for only those papers cited more than the set thresholds. 
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Limit analytical lists and List of All Records to [nn] pages. Fill in a value for nn to limit 

lists to the first pages of a sort. 

Apply the above limit to date and alphabetical sorts. Unset this limit to include the  alpha 

list of all authors, for example, in Author List, or all records in date-sorted List of All Records. 

Do not create popup lists for items with [nn] records or fewer Set a value of nn to limit 

popup lists to the authors, journals, etc. with largest number of records.This will avoid 

producing large numbers of secondary lists with small numbers of records. 

Limit popup lists to [nn] records Set a value of nn to restrict the size of popup 

lists. 

6. Modifying Your Collection 

This chapter gives details about the various ways you can edit and add records to your 

collection. 

    Editing individual records(See 6.1) 

    Adding records manually(See 6.2) 

    Editing data with the Edit Tool(See 6.3) 

    Adding Records from the Cited Reference List(See 6.4) 

6.1 Editing individual records 

You can examine the complete content of an individual record by clicking on its record 

number in any list that shows records. 

Click on the Edit link to open a second window that will allow you to manually edit the 

individual record. 

When entering or editing a record, ensure that the data is entered in the standard Web of 

Science format, paying attention to the following conventions. 

    Author(s): last name followed by initials, with no punctuation, one author per line. 

    Title: Full title with correct spellings 

    Source: Ensure that you use the standardized name according to Web of Science Source 

Index. 

    Volume, Issue, Start page, End Page: Use numeric data. 

    Source Abbrev: 

    Date - Year, Month, Day: Used for sort order by date and for Yearly Output analysis 

    Type - Journal, Document:  The "Journal" field shows Web of Science publication code 

which is not used by HistCite for analysis. The "Document" field contains the document type 

description, which is used in the "Document Type" analysis. Use Web of Science standard 

document types. 

    Language: Always enter the language, if you want to analyse by language. 

    GCS: Global Citation Score is available by searching for the document in Web of Science. 

Enter as an integer with no punctuation.  

    Comment: Not used by HistCite for analysis. Enter free text. 
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    Address: Enter in Web of Science standard format - a single line per address, with elements 

divided by commas. Always include the country as the last element.  

    Reprint: Not used by HistCite for analysis, unless authorized by Settings...(See 7.4.8). Use 

same rules for entry as Address field, but include the author name as th first item. 

    E-mail: Not used by HistCite for analysis 

    Abstract: Not used by HistCite for analysis 

Once you have edited the data, click on "Apply changes" to save the edited record. 

Don't forget to Save your collection regularly when you are carrying out edits -- 

Applying specific changes to individual records does not save the whole collection. 

6.2 Adding records manually 

It is possible to enter a record manually into your collection. This may be desirable, 

especially for documents that are not included in Web of Science, e.g. books and other 

non-journal articles. 

Select "New record..." from the File menu. 

When entering a new record, ensure that the data is entered in the standard Web of Science 

format, paying attention to the following conventions. 

    Author(s): last name followed by initials, with no punctuation, one author per line. 

    Title: Full title with correct spellings 

    Source: Ensure that you use the standardized name according to Web of Science Source 

Index. 

    Volume, Issue, Start page, End Page: Use numeric data. 

    Source Abbrev: 

    Date - Year, Month, Day: Used for sort order by date and for Yearly Output analysis 

    Type - Journal, Document:  The "Journal" field shows Web of Science publication code 

which is not used by HistCite for analysis. The "Document" field contains the document type 

description, which is used in the "Document Type" analysis. Use Web of Science standard 

document types. 

    Language: Always enter the language, if you want to analyse by language. 

    GCS: Global Citation Score is available by searching for the document in Web of Science. 

Enter as an integer with no punctuation.  

    Comment: Not used by HistCite for analysis. Enter free text. 

    Address: Enter in Web of Science standard format - a single line per address, with elements 

divided by commas. Always include the country as the last element.  

    Reprint: Not used by HistCite for analysis, unless authorized by Settings...(See 7.4.8). Use 

same rules for entry as Address field, but include the author name as th first item. 

    E-mail: Not used by HistCite for analysis 

    Abstract: Not used by HistCite for analysis 

Once you have added the data, click on "Apply changes" to save the new record. 

Don't forget to Save your collection regularly when you are carrying out edits -- 

Applying specific changes to individual records does not save the whole collection. 
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6.3 Editing data with the Edit Tool 

It is not uncommon to find inconsistencies in the data downloaded from Web of 

Science. For example, authors may not have their full initials included or there 

may be spelling variations. In addition, cited references and addresses 

frequently show variations due to differences in journal styles and data keying. 

The Edit tool allows you to conveniently edit data elements in the Authors, Cited 

References, Institutions, and Institutions with Subdivision tables. 

Use the Edit tool as follows 

    Open the Edit tool by selecting "Edit" from the Tools menu. 

    Select the check box of the record(s) you wish to edit. 

    In the Edit tool, enter the correct text. 

    Check or uncheck the "Defer network update" box. If you check "Defer" the 

change in the data will be made, but updating the network will be deferred. 

Recalculation of a network can be time consuming, and you may wish to defer it 

until all your changes are made. 

    Click Proceed. A confirmation dialog will ask you to confirm the change. Click 

OK to accept the change. 

    If you have checked "Defer Network Update" a red link "Update lists" will 

appear in the Analyses Index to alert you that the data has been altered but the 

network has not been recalculated. Otherwise the network recalculation will take 

place immediately. 

Don't forget to Save your collection regularly when you are carrying out edits -- 

Applying specific changes to individual records does not save the whole collection. 

6.4 Adding records from the Cited Reference list 

From the Cited Reference list, references that are not included in the current collection may 

be converted into records in the collection. It is frequently the case, when doing a keyword 

search in Web of Science (WoS) that highly relevant articles are missed, because they don't 

have the keyword in their title, or they use variant terminology, etc. 

The Cited Reference list provides an excellent way of identifying important articles that were 

"missed" by Web of Science search. In addition it will help to identify publications such as 

books and other publications not indexed by Web of Science.  

In the sample file, click on "Cited References" in the Analyses Index. Item #5 in the list is the 

following paper: 

PRICE DJD, 1965, SCIENCE, V149, P510 

This article is cited 43 times by other records in the collection, suggesting it is 

highly relevant to the topic of "citation analysis". However, it was "missed" by the 
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search because the search phrase "citation analysis" does not appear in the 

WoS record. 

There are three methods that can be used to fully incorporate a cited reference 

into a collection. The method you use will depend on the nature of the reference, 

the availability of the required data, and the number of references you want to 

convert. 

1. Manual Method(See 6.4) 

2. Web of Science lookup, with manual data entry(See 6.4). 

3. Web of Science lookup, with data import.(See 6.4) 

1. Manual Method 

    Click on the "make record' button for the cited reference. The "new record" 

dialog will open, with the information from the cited reference inserted in the 

appropriate fields. 

    In order to fill in the additional information for the record you will need to locate 

the book or journal and type in the information, as described under "Adding 

records manually(See 6.2)" 

2. Web of Science lookup, with manual data entry. 

If the cited reference is published in a journal indexed by Web of Science, you 

can look it up using the WoS link. 

1.   Open Web of Science. 

2.   Click on the WoS link. A "Cited Reference Search" of Web of Science is 

initiated, and the results are displayed.  

(When you do this for the first time, you may have to log in to Web of Science 

and repeat the search. If the search does not work, try changing the settings to 

one of the manual setup methods described in Settings - WoS Link(See 7.4.8)). 

3.   If more than one record is shown, select the correct record, and click on the 

"View Record" link. 

4.    When the article record appears you can copy and paste the data from 

Web of Science into a new record, created as described in 1. Manual Method. 

You may need to hand edit some of the data to conform to Web of Science 

export format. 

3. Web of Science lookup, with data import. 

To automate the process further, especially if you are planning to convert a 

number of cited references into records in your collection, it is advisable to 

export data from Web of Science and import it into your network, as follows.  

1.   Carry out steps 1 - 4 from section 2 above.  

2.   When the record you want is showing in Web of Science, click on "Add to 

Marked List", then close the window. 



HistCite Help 

 29 

3.   Repeat with additional cited references from your collection, if desired. 

4.   Once you have added all the records you want to the Marked List in Web of 

Science, you are ready to export the Marked List to a text file. Click on the 

"Marked List" button at the top of the page in WoS. 

5.   In "Step 1" select the following fields for export: 

    Author 

    Title 

    Source 

    Language 

    Document Type 

    Addresses 

    Cited References 

    Cited Reference Count 

    Times Cited 

You may also export the Abstract and E-mail address fields, though this will slow 

down the export. 

6.   In "Step 2" Select the "Field Tagged" option beside the "Save to File" button 

then click on the "Save to File" button.  

7.   The system will prepare a text file and eventually show a page with a "Save" 

button. Save the file with an appropriate name in a location where you can find it 

later. 

8.   Import the saved text file into your collection using the "Add File...(See 7.1.1)" 

command in the File menu. 

Don't forget to Save your collection regularly when you are carrying out edits -- 

Applying specific changes to individual records does not save the whole collection. 

7. Menu Guide 

This chapter describes the commands available in the menu bar. 

     File Menu(See 7.1) 

     Analyses(See 7.2) 

     View(See 7.3) 

     Tools(See 7.4) 

     Help(See 7.5) 

7.1 File Menu 

The File Menu has the following members. Click on the command for a more detailed 

explanation.  
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    Add File...(See 7.1.1) : Add more Web of Science Export Files to the current collection 

    New record...(See 7.1.2): Creates a new record for manual data entry 

    Close(See 7.1.3): Closes the current collection. 

    Save(See 7.1.4): Save the current collection in a text file. 

    Save as...(See 7.1.5): Save the current collection in a text file with a new name 

    Export(See 7.1.6): Export the collection as an HTML presentation. Export table as a CSV file. 

    Properties...(See 7.1.7): Add a title and description to the collection 

    Print...(See 7.1.8): Print the current table 

    Quit(See 7.1.9): Quit the program 

7.1.1 Add File... 

The "Add File..." (Alt-F) command is the standard way of adding a Web of Science export file 

to an existing collection, or starting a new collection. 

    Select the command to open the Add File dialog. 

    Click the "Browse..." button and locate the text file in WoS export format or HistCite format. 

    Click "Add file" to add the file to the collection.  

When a file is added to the collection, all the analyses are recalculated. 

Please note that HistCite only imports unique WoS records for analysis.  For a detailed 

report of your import, from the "Tools" menu click on "Logs..." 

 

NOTE: If you are using Internet Explorer 8, you may see an error message, such as File: 

"C:\fakepath\HistCiteSample.txt": No such file or directory", when you try to add a new file 

using the File -> Add... menu. This is due to some changes introduced in Internet Explorer 8. 

Go to Troubleshooting >"Fakepath Error(See 9.2)" for a solution. 

7.1.2 New record... 

Select "New record..." to open a new blank record. 

 

See "Adding records manually(See 6.2)" for details. 

7.1.3 Close 

The "Close" command closes the current collection. 

Note that if you repeatedly open and close collections, the memory requirements of HistCite 

will increase, as memory is not fully released when a collection is closed.  

In order to release memory fully, you must quit and restart HistCite. 
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7.1.4 Save 

Select "Save" to save the current collection with the current file name. 

 

The "Save" command is not available if the collection has not been edited. 

7.1.5 Save as... 

Select "Save as..." to save the current collection in a new HistCite file. 

The saved file is in the same format as Web of Science export format, but has additional 

information relating to HistCite. HistCite files have the extension .hci. 

Note: If you want to work on the recently saved file created with the "Save As..." 

command, rather than the original file, you must Close the current file and Add the 

new file. Unlike many programs HistCite does not swap to the newly saved file when 

you use the "Save as..." command.  

7.1.6 Export 

The "Export" command provides several options for exporting data from the current HistCite 

collection. 

    Export -> Records...: This command allows you to create HistCite compatible files for 

subsets of the records in your current collection. For example, from a filtered list of records or 

from a list of records with a specific tag. 

The command is only available when a page with a subset of records is showing. 

    Export -> As CSV...: This command allows you to export analytical tables to a 

comma-separated value text file suitable for further analysis in Excel or a database program. 

The List of All Records and all the tables in the Analyses Index can be exported in this way. 

    Export -> HTML presentation...: This command allows you to export the current collection as 

a set of HTML pages suitable for publishing on a web site. See 

http://garfield.library.upenn.edu/histcomp/ for many examples. (Note that some of the 

samples on this web site were prepared with older versions of HistCite and newer features 

may be missing). 

See the page on "HTML Presentations(See 5.)" for complete information on exporting HTML. 

7.1.7 Properties... 

The "Properties..." command opens a dialog where title and other parameters of the 

collection can be entered and modified. 

     Title: Short title of the collection (will be displayed on all pages) 

     Description: Description of the collection (will be displayed when title is hovered over) 

     Collection date of creation: Enter a date for collection creation. By default the date when the 

collection is first opened and saved in HistCite is entered here. 

http://garfield.library.upenn.edu/histcomp/
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     Comment: Any other information about the collection you want to store (not displayed). 

Note: This dialog can also be opened by clicking on the collection title on any page. 

7.1.8 Print... 

The "Print..." prints a screen dump of the current page to the chosen printer. 

For multi-page tables, only the currently visible page is printed. 

7.1.9 Quit 

The "Quit" command closes the currently active HistCite browser window and the HistCite 

program. 

Note that any auxiliary HistCite windows that are open will not be closed. 

7.2 Analyses 

The Analyses menu shows the same headings as the Analyses Index(See 3.). Analyses 

menu items show the number of items in that analysis table. The currently selected analysis 

is shown in bold. 

Follow these links to go to the appropriate page in the Analyses Index chapter. 

    Records(See 3.1) 

    Authors(See 3.2) 

    Journals(See 3.3) 

    Cited References(See 3.4) 

    Words(See 3.5) 

    Marks(See 3.7) 

    Tags(See 3.6) 

    Yearly output(See 3.8) 

    Document Type(See 3.9) 

    Language(See 3.10) 

    Institution(See 3.11) 

    Institution with Subdivision(See 3.12) 

    Country(See 3.13) 

7.3 View 

The View menu provides a choice of three styles of presentation: Standard, 

Bibliometric and Custom view. "Customize" allows you to create your own 

Custom view. 

    Standard(See 7.3.1) 

    Bibliometric(See 7.3.2) 
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    Custom(See 7.3.3) 

    Customize(See 7.3.4) 

The current view is indicated in the menu in bold text with a bullet. The selected 

view, and any customizations are preserved between HistCite sessions.  

7.3.1 Standard 

"Standard" view is the standard presentation of the data described in this User Guide, and is 

selected by default. 

7.3.2 Bibliometric 

The "Bibliometric View" shows several additional parameters that may be useful to users 

with more analytical or specialized needs. The analytical tools included are experimental and 

will be expanded in future versions of HistCite. 

The Bibliometric View includes the parameter LCSx, which is the LCS excluding 

self-citations.  A self-citation is when any of the authors from the source paper is found 

among the authors of the citing paper. Hence the LCSx excludes author self-citations, but 

does not exclude journal 

self-citations.                                                                                                                            

                                 

The Bibliometric view also provides several means of looking at the rate at which citations to 

a paper are accumulated. LCS/t and GCS/t show citations per year. LCSb and LCSe show 

citations at the beginning -- immediately after a paper is published -- and recently, allowing 

users to assess if a paper was cited soon after publication, or was a "sleeper". 

See the following topic for information on how to compute an h-index(See 7.3.2.1). 

The following are the parameters presented. 

List of All Records  

In Collection Statistics at top right: 

 

Grand Totals 

    LCS: Sum of Local Citation Scores for all records in the collection. 

    LCSx: Sum of Local Citation Scores excluding author self-citations for all records in the 

collection. 

    GCS: Sum of Global Citation Scores for all records in the collection. 

    CR: Cited References. This number is the total of references in all papers in the collection, 

including references cited in multiple records. 

    NA: Number of Authors 

Means 

Averages per record in the collection for each parameter in the first line 

Collection span 
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Shows number of years covered by collection. On hovering, shows the number of records in 

the collection that are used to calculate the "beginning" (b) and "end" (e) statistics. (The span 

of years for calculating LCSb and LCSe can be set to different values in the Settings...(See 

7.4.8) dialog) 

In Table 

    LCS = Local Citation Score: Number of citations to the paper from within the collection. 

    LCSx = Local Citation Score excluding self citations: Number of citations to the paper from 

within the collection excluding author self-citations. 

    LCS/t = Local Citation Score per year from paper publication to the end of the collection  

    GCS = Global Citation Score: Number of citations to the paper from all sources, as reported 

in Web of Science when the data was downloaded. 

    GCS/t = Global Citation Score per year from paper publication to the end of the collection  

    NA = Number of authors 

    LCR: Local Cited References: Number of records in the collection that are cited by the paper. 

This number is an indication of the relevance of the paper to the collection. 

    CR: Number of Cited References: Total number of cited references in the bibliography of the 

paper. 

    LCSb = Local citations at beginning of the time period covered. It is calculated as explained 

under "Collection Span" above.  

    LCSe = Local citations at the end of the time period covered. 

    LCS e/b = Ratio of local citations in the end and beginning periods. This ratio shows whether 

a paper gained more of its citations in the period immediately after publication (LCS e/b < 1) 

or if there has been a relative increase in citations in recent years (LCS e/b >1).  

Notes: If the paper has been published for less than the total of the defined beginning and 

end periods (a default value of 6 years) the ratio is not calculated. 

If the ratio has zero as the numerator or denominator, the actual ratio of papers is shown, 

rather than the calculated value.  

All Author List  

    Percent = percent of total papers in the collection written by author  

    TLCS/t = Total Local Citation Score is the sum of LCS/t scores for papers by a given author.  

    GCS/t = Total Global Citation Score is the sum of GCS/t scores for papers by a given author.  

    TLCR = Total Local Cited References  

    TLCSb = Local citations in beginning period, calculated as explained under "Collection 

Span" above. 

    TLCSe = Local citations in end period, calculated as explained under "Collection Span" 

above. 

Journals  

Same additional headings, excluding TLCSb and TLCSe  

Cited References  

Percent = percent of total papers in the collection that cite this reference  

Title Word List  

Percent = percent of total papers in the collection that contain this word in the title  

Other analytical lists  

Percent = percent of total papers in the collection that contain this item 
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Article Record Detail  

On right hand side a table and histogram of Local Citations to this paper per year are 

displayed. 

    Column 1 = Year  

    Column 2 = Cumulative Citations  

    Column 3 = Citations in the year  

    Column 4 = Histogram of column 3  

    LCS/t = Local Citation Score per year from paper publication to end of collection 

    GCS/t = Global Citation Score per year from paper publication to  end of collection 

    LCSb = Local citations in beginning period  

    LCSe = Local citations in end period 

7.3.2.1 h-Index 

The h-index is a metric that attempts to gauge both the scientific productivity and the 

apparent scientific impact of a scientist. The index is based on the set of the scientist's most 

cited papers and the number of citations that they have received. 

Formally, a scholar with an index of h has published h papers each of which has been cited at 

least h times. 

HistCite provides an h-index statistic based on three sets of citation data. To display these 

h-indices, proceed as follows: 

    Switch to Bibliometric View in the View Menu. 

    Create a filtered list of publications for a specific author. You can do this either by clicking on 

an author's name in a list of records, or by clicking on the author's record number in the 

All-Author List. 

    The Collection statistics panel at the top right displays three h-index statistics. 

 

h-index (LCS) is the h-index based on the local citations in the collection. In the example 

above, the author has published 4 papers with 4 or more citations. 

h-index (LCSx)  is the h-index based on the local citations in the collection excluding 

self-citations. In the example above, the author has published only 1 paper with 1 or more 

external citations. The LCSx-based h-Index has great value in a collection where all of an 

author's papers plus all the citing papers have been downloaded from Web of Science. 

h-index (GCS)  is the h-index based on the global citation scores downloaded when the 

collection was created. Note that this may not be the same as the author's h-index computed 

on in Web of Science website, as it includes only the downloaded papers by the author and 

not all the papers published by the author. 

7.3.3 Custom 

The "Custom View" shows the parameters and style of record display selected by the user 
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using the "Customize(See 7.3.4)" dialog in the View Menu. 

7.3.4 Customize 

The "Customize" menu option allows the user to select which parameters from the Standard 

and Bibliometric Views the user wants to display. 

 
Select the columns you want to include in your Custom view by checking the checkboxes at 

the top of the columns.  

Use the first set of radio buttons to select "Full" or "Brief" record display. The "Full" display is 

the default option. "Brief" records omit article titles and show only first author. 

Use the second set of radio buttons, under Analyses Lists to select to show the percent 

column in the analyses. The percent column shows the percentage of all records for each 

author, journal, country, etc. 

Use the third set of radio buttons under "Statistics" to show or hide the various h-index 

statistics. 

Once you have selected your Custom View parameters, click Customize to show your 

Custom view. 

The Custom View you create will be stored between sessions. 

7.4 Tools 

The Tools menu allows the user to switch on and off various utilities that assist with analyzing, 

navigating and editing the collection. 

    Graph Maker...(See 4.) 
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    Historiographs(See 7.4.2) 

    Search(See 7.4.3) 

    Move to(See 7.4.4) 

    Mark & Tag(See 7.4.5) 

    Edit(See 7.4.6) 

    Analyses Index(See 7.4.7) 

    Settings...(See 7.4.8) 

    Log...(See 7.4.9)  

7.4.1 Graph Maker... 

The "Graph Maker..." menu command opens the Graph Maker window. Go to the "Graph 

Maker(See 4.)" chapter for complete details.  

7.4.2 Historiographs 

The "Historiographs..." menu command opens a window that displays a list of historiographs 

saved in Graph Maker.  

The command is only available if there are saved graphs. See the "Graph Output(See 4.3)" 

chapter for details on how to save graphs. 

7.4.3 Search 

The "Search" command invokes a set of tools that can be used to construct simple searches 

of the records in a collection. 

Single terms can be entered in the search fields. The Search function does not support 

Boolean operators, multiple word phrases or truncation. 

An asterisk (*) can be used as a wild card 

Examples 

    Author: Smith JN, Smith J*, Smith*. Note that "Smith" will not find any authors 

with initials. The asterisk * must be used. 

    Journal: NATURE, JOURNAL OF BIO*, *GENE*  

    Title Word: PACIFIC, FISH*, *GENE*. Do not use quote marks or spaces. 

    Publication Year: Single year e.g. 1992 or Year Range e.g. 1989-1995. Wild 

cards are not supported in this field. 

After entering your search terms, click on "Search collection". The search results 

appear below the dialog. 

You can refine your search by entering another set of terms and clicking on 

"Search within results". 
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The Search dialog may be used in conjunction with the "Mark & Tag(See 7.4.5)" 

dialog, so that you can preserve your search results. 

To close the Search dialog, click on the close button "x" in the upper right corner, 

or select any link in the Analyses Index. 

7.4.4 Move to 

The "Move to" command opens the "Move" tool. The Move tool provides a convenient way of 

moving rapidly through a large collection of records.  

The drop down field in the Move tool lists all the table column headings and sort elements in 

the current table. Hence, the drop down menu will show different choices depending on the 

currently active table. 

Examples 

    In the All Records List, select "Year" from the drop down menu, type "1998" in the field and 

click "Go" to go directly to the first record for 1998. 

    In the Author analysis page, select "GCS" from the drop down menu, type in "20" and click 

"Go" to go directly to the first author with total Global Citation Score = 

    In the "Cited Reference" analysis page, select "Journal" from the drop down menu, type in 

"N" and click "Go" to go directly the first cited reference where the journal name starts with 

"N". 

Note: The Move tool sorts the list by the parameter selected from the menu, so all items that 

meet your criteria are grouped together.  

To close the Move tool, select "Move to" from the Tools menu, or click the "x" (close) box in 

the upper right corner. 

7.4.5 Mark & Tag 

HistCite offers 2 ways for users to create subsets of records in a collection -- Marking and 

Tagging. While similar in many ways, each has its own uses. 

Named tags can be attached to records and permanently stored in a HistCite file. Records 

may have multiple tags attached to them. 

Marks are temporary, and can be used to mark a selection of records "on the fly". The Graph 

Maker can create a historiograph from marked records. A record may be marked only once. 

How to Mark and Tag Records 

    Open the Marking and Tagging tool from the Tools Menu. (Also opens with Alt-M keyboard 

shortcut). When the tool opens, you will notice that each record now has a check box. 
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The Marking and Tagging tool is organized in three parts.  

Set Criteria: 

The first column of the tool.gives you several options for selecting records 

    "Select all records from the current list": If you have created a filtered list or are viewing the 

results of a search, this gives you a way to store the results. 

    "Select all marked records" (Only available if you have previously created a marked list). 

This allows you to permanently tag a marked list. 

    "Select records with...." allows you to set criteria for the records you want.  

    The first field allows you to select a parameter. The parameters allowed vary with the list. For 

example you can select LCS, GCS, LCR or CR in the List of All Records. 

    The second field allows you to specify how the values of the parameter you selected will be 

evaluated. You can select a "Range", values "Equal to", "Not Equal to", "Greater" than or 

"Less" than the value you specify in the third (and fourth) field(s). 

    The third field allows you to enter the value. 

    The fourth field allows you to enter the upper value if you have specified "Range". 

For example you might select all records in a collection with LCS value greater than 20. 

    "Select records checked on this page" allows for manual selection. Use the check boxes on 

each record to select it for marking or tagging. Immediately below the radio button for this 

control are two buttons which are provided for convenience. 

    "Clear checks" allows you to clear all the checkboxes and start again. 

    "Invert checks" allows you to check all unchecked records and uncheck all checked records. 

This can be convenient if you want to select most but not all records on a page. Check those 

that you do NOT want, then click "Invert checks". 

Set Scope: 

The second column of the tool gives you options for setting the scope of the selections you 

have made in the first column. One, two or all three of these checkboxes must be checked. 

    "Selected records only" acts on the records selected in the first column. 

    "Records citing selected records" will act on any records in the collection that cite the 

records that meet the criteria set in the first column. 

    "Records cited by selected records" will act on any records in the collection that are cited by 

the records that meet the criteria set in the first column. 

These two options would be useful if you want, for example, to mark subsets of records that 

are published in a certain journal and all the records that cite them. 

Take Action:   

The third column allows you to mark or tag the records you have selected. This column is 

divided into two sections. 

The top three buttons allow you to control the "mark" function. 

    "Mark" button will mark the records specified. It will also check the checkboxes of each 

marked record. You will also notice that the "Marks:" item appears in the Analyses Index with 

the number of marked records indicated. Click on the word "Marks:" in the Analyses Index at 

any time to bring up the list of marked records. 

    "Unmark" button removes marks from records in the collection based on the selection 

criteria. 
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    "Delete" button - USE WITH CARE. The "Delete" button will delete records from the 

collection based on the selection criteria 

The remainder of the fields and buttons control tagging actions. 

    The Tag: and Description: fields allow you to enter an alphanumeric tag name and 

description. The description is optional. Tag names may be alphanumeric and any length, 

though short names are more convenient. 

    "Tag" button will tag the records specified in the selection criteria with the named tag. 

    "Untag" button. This can be used in two ways. 

    Type in the name of the tag you want to remove and click on Untag to remove the named tag 

based on the criteria you have set in the Mark & Tag tool. 

    For an easy way to remove a tag without typing in its name, go to the Tags page by clicking 

on Tags: in the Analyses Index, or select Tags from the Analyses menu. Check the checkbox 

of the tag you want to remove, click the "Select records checked on this page" radio button 

and click on "Untag".  

    "Remove all tags" will remove all tags from the records specified in the selection criteria. 

7.4.6 Edit 

The Edit tool allows you to conveniently edit certain data elements in the Authors, Cited 

References, Institutions, and Institutions with subdivision tables. 

Go to the "Editing data(See 6.3)" topic in the "Modifying Your Collection(See 6.)" chapter for 

details on how to use this tool. 

7.4.7 Analyses Index 

The Analyses Index menu item allows you to switch the Analyses Index on and off. The 

functions in the Analyses Index are described in detail in the " 

7.4.8 Settings... 

The "Settings..." menu item opens the Settings dialog. 

The Settings dialog is context-sensitive, showing only the elements that are relevant to the 

active page. To see the complete Settings dialog (if it is not showing), click on "All settings". 

HistCite preferences are saved in a file called histcite.conf, located in the same folder as the 

program. 

The following describes all the settings. 

General 

These settings apply throughout HistCite. 
    Font Size: Font size changes the display font size in lists and tables. The default is 

"medium".  

    Show tips during program start. Check this box to enable the "Tip of the Day" feature. 
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    "Show page index () Regular () Extended." 

Check the box to display the page index. The regular page index shows the number of pages 

in a view. Click on a page number to go to the page. The extended page index shows, in 

addition, the value of the first item on the page, based on the sort order. e.g. in the Author list 

sorted by author name it shows the first author on each page. See Navigation(See 2.5) for 

more details. 

    Save Graph Maker settings 

Allows your Graph Maker settings to be saved in the preferences file. Otherwise Graph 

Maker will use default settings. 

Optional Analysis Lists 

    Checkboxes for Cited References and Words analyses.  

These checkboxes allow you to switch off these analyses, which saves time when 

processing large collections. 

    In Bibliometric View Only: Settings allow user to set the year span for beginning 

and end year time periods. See Bibliometric View(See 7.3.2) for more details.  

Record Lists 

    Table header interval; page size. 

The table header interval value determines the repetition frequency of the table header row 

in tables. Page size determines the number of rows per page, and the << and >> navigation 

bar control behavior.   

    Limit number of authors shown per record to [n] names.  

Check this box and enter a number to limit the number of authors shown per record in a 

record list. 

Analysis Lists 

    Table header interval; page size. 

Controls the display of analysis tables, in the same manner as described above for Record 

Lists. 

At the end of the General Settings is a "Restore All Defaults" button which will overwrite your 

saved preferences file with default values. 

Word List 

These settings affect the content and appearance of the Word Analysis. 

    Include title words 

Check this box to include words appearing in an article title. 

    Exclude stop words 

Check this box to eliminate Stop Words(See 8.1) from the analysis. Stop words are words that 

are used so frequently that it is common to omit them when compiling topical dictionaries. 

The default is to exclude stop words. 

    Exclude words of [2] characters or shorter 

Eliminates short words from the Word Analysis. If this value is set to 0, words of all lengths 

are shown. 

The default value is 2 characters. 

    Split hyphenated terms into words. 

Check this box to count hyphenated words as separate words. By default hyphenated words 
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are treated as one word for analysis.  

    Include Author keywords 

Check this box to include Author keywords. Keywords provided by the author or the journal 

are included in some more recent WoS records. 

    Include Web of Science Keywords Plus. 

Check this box to include Web of Science Keywords Plus. KeyWords Plus® are index terms 

created by Thomson Reuters from significant, frequently occurring words in the titles of an 

article's cited references, and are found in more recent WoS records. 

    Split multi-word terms into words 

Author and WoS keyword lists may contain word phrases. Check this box to split multi-word 

terms into individual words. 

    Split hyphentated terms into words 

Check this box to split hyphentated terms from the keyword lists into individual words. 

    Show keywords distinctly (in italics, and bold if found in titles as well) 

Check this box to display words from the keyword lists in distinct type styles. 

    Show words in () UPPER CASE   () lower case 

Use this to change the appearance of the Word Analysis. Note that Abbreviations like DNA 

will be rendered as "dna" if "lower case" is selected. 

The default value is UPPER CASE. 

WoS link 

This section allows you to set the parameters for searching Web of Science from 

within HistCite from the Cited Reference Analysis page. 

 () Universal Setup is the default value and this will work automatically in most 

cases. 

If the WoS search function does not work, try the manual setting. 

() Manual Setup version 4 

Click the radio button and enter the search URL.  

How to set the lookup URL in HistCite for Web of Science Manual Searches 

(Unfortunately Web of Science does not provide completely standard URLs for 

searches initiated from outside. The following procedure may be requireded to 

ascertain the correct URL. Although the URL is stored in HistCite, you may have to 

redo this procedure, as the URL can change depending on circumstances) 

1.   Do a cited reference search in WoS (it doesn't matter what you search). 

2.   When the results appear, right-click in the results area, and select "Properties". 

3.   Copy the URL from the Properties dialog and paste it into the appropriate "ISI Web 

of Science location:" field in the Settings dialog. 

The URL will end in:...CitedReferenceSearch. 

See "Adding records from the Cited Reference list(See 6.4)" for details on how to use the 

results of a search. 
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Address Lists 

Settings in this section affect the source of data used by HistCite for address analysis. Your 

choice of setting depends on the quality of source data in Web of Science and the policies of 

the journals in your collection. 

    Use available Reprint address  

( ) Never  

( ) When no other address is available  

( ) Always 

Country List 

HistCite provides tools to deal with some problems of inconsistencies with country names in 

Web of Science that lead to difficulties in the Country Analysis. See Country Lists(See 8.3) for 

complete details. 

HTML Presentation 

HistCite provides many settings for modifying the content of HTML presentations. This is 

described in detail in the section on HTML Presentations(See 5.) 

7.4.9 Log... 

Select "Log..." from the Tools menu to display the log of processing activities that have been 

carried out in the current session.  

7.5 Help 

There are four items in the Help menu. 

 

    "Help" is a context-sensitive link to this file. It will open the appropriate page depending on 

where you are in HistCite. 

    "Glossary" opens the Glossary(See 8.2) page in this Help system. 

    "Tip of the Day" displays the HistCite tip window. Click the controls at the bottom of the 

window to view the next or previous tips, to close the window, and to control whether the 

window is displayed automatically when HistCite is started. 

    "Web Site" links to the HistCite Web site." 

    About HistCite" opens an "About" dialog box with version number and other information. 

8. Reference 

This chapter provides reference information not available elsewhere in the Help 

documentation 

    Bibliometric View(See 7.3.2) 
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    Stop Words(See 8.1) 

    Glossary(See 8.2) 

    Country Lists(See 8.3) 

    Version Changes(See 8.4) 

8.1 Stop Words 

Words that are used so frequently that it is common to omit them when compiling topical 

dictionaries. 

 

In HistCite these words are omitted from the Words(See 3.5) analysis page by default. They 

may be included by changing the settings in the Settings dialog. 

   

ABOUT 

ABOVE 

ACCORDING 

ACROSS 

ACTUAL 

ADDED 

AFTER 

AGAINST 

AHEAD 

ALL 

ALMOST 

ALONE 

ALONG 

ALSO 

AMONG 

AMONGST 

AND 

AND-OR 

AND/OR 

ANON 

ANOTHER 

ANY 

ARE 

ARISING 

AROUND 

AWARD 

AWAY 

BECAUSE 

BECOME 

BECOMES 

BEEN 

BEYOND 

BIRTHDAY 

BOTH 

BUT 

CAN 

CERTAIN 

COME 

COMES 

COMING 

COMPLETELY 

CONCERNING 

CONSIDER 

CONSIDERED 

CONSIDERING 

CONSISTING 

DEPARTMENT 

DER 

DESPITE 

DISCUSSION 

DOES 

DOESNT 

DOING 

DOWN 

DUE 

DURING 

EACH 

EITHER 

ESPECIALLY 

FEW 

FOR 

FORWARD 

HAS 

HAVE 

HAVING 

HIS 

HONOR 

HOW 

INSIDE 

INSTEAD 

INTO 

ITEMS 

ITS 

JUST 

LET 

LETS 

LITTLE 

LOOK 

LOOKS 

MADE 

MAKE 

MAKES 

MAKING 

MANY 

MEET 

MEETS 

MORE 

MOST 

MUCH 

MUST 

NEAR 

NEARLY 

NEXT 

OTHER 

OUR 

OUT 

OUTSIDE 

OVER 

OVERALL 

PER 

POSSIBLY 

PUT 

REALLY 

REGARDING 

REPRINTED 

SAME 

SEEN 

SEVERAL 

SHOULD 

SHOWN 

SINCE 

SO-CALLED 

SOME 

SPP 

STUDIES 

STUDY 

SUCH 

TAKE 

TAKEN 

TAKES 

TAKING 

THAN 

THAT 

THE 

TOGETHER 

TOWARD 

TOWARDS 

UNDER 

UNDERGOING 

UPON 

UPWARD 

VARIOUS 

VERSUS 

VERY 

VIA 

VOL 

VOLS 

WAS 

WAY 

WAYS 

WE 

WERE 

WHAT 

WHATS 

WHEN 

WHERE 

WHICH 

WHILE 

WHITHER 

WHO 

WHOM 

WHOS 

WHOSE 

WHY 

WITH 
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BEFORE 

BEHIND 

BEING 

BELOW 

BEST 

BETTER 

BETWEEN 

FROM 

FURTHER 

GET 

GIVE 

GIVEN 

GIVING 

NOT 

NOW 

OFF 

ONLY 

ONTO 

THEIR 

THEM 

THEN 

THERE 

THEREFROM 

THESE 

THEY 

THIS 

THOSE 

THROUGH 

THROUGHOUT 

WITHIN 

WITHOUT 

YET 

YOU 

YOUR 

 

8.2 Glossary 

    GCS - Global Citation Score shows the total number of citations to a paper in 

Web of Science.  

    LCR - Local Cited References shows the number of citations in a paper's 

reference list to other papers within the collection.  

    LCS - Local Citation Score shows the count of citations to a paper within the 

collection.CR - Number of Cited References shows the number of cited 

references in the paper's bibliography.  

    Recs - Number of Records shows the number of records where a given item 

is found.  

    T* - Total [score]  Any Total score represents a sum of respective scores for 

all records from a given author, source, other category, or all records. e.g. TLCS 

= Total Local Citation Scores. 

    Stop Words Words that used so frequently so that it is common to omit them when 

compiling topical dictionaries. See the full list here.(See 8.2) 

 

Bibliometric View Only 

    LCSx - Local Citation Score excluding self-citations shows the count of 

citations to a paper within the collection excluding author self-citations. 

    LCS/t = Local Citation Score per year from paper publication to the end of the collection  

    GCS/t = Global Citation Score per year from paper publication to the end of the collection  

    LCSb = Local citations at beginning of the time period covered. It is calculated as explained 

under "Collection Span" above.  

    LCSe = Local citations at the end of the time period covered. 

    LCS e/b = Ratio of local citations in the end and beginning periods. This ratio shows whether 

a paper gained more of its citations in the period immediately after publication (LCS e/b < 1) 

or if there has been a relative increase in citations in recent years (LCS e/b >1).  
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8.3 Country Lists 

Country Settings 

There are some problems of inconsistency with country names in Web of Science that lead 

to difficulties in the country analysis. In addition, there have been country name changes, 

splits and unifications that lead to confusion. HistCite provides the following options for 

handling some of these issues. 

Former USSR 

As a default the following are included under USSR. To treat them as separate countries, 

uncheck the USSR box in the Country List Settings. 

ARSSR - Armenian SSR 

AZSSR - Azerbaijan SSR 

BESSR - Belorussian SSR 

ESSSR - Estonian SSR 

GESSR - Georgian SSR  

KASSR - Kazakh SSR  

KISSR - Kirgiz SSR  

LASSR - Latvian SSR  

LISSR - Lithuanian SSR  

MOSSR - Moldavian SSR  

TASSR - Tadzhik SSR  

TUSSR - Turkmen SSR  

UKSSR - Ukrainian SSR  

USSR - Russian SFSR  

UZSSR - Uzbek SSR 

United Kingdom 

As a default the following are included under UK. To treat them as separate countries, 

uncheck the UK box in the Country List Settings. 

England 

Northern Ireland 

Scotland 

Wales 

Former Federal Republic of Germany 

As a default the following variants are included under FRG. To treat them as separate, 

uncheck the FRG box in the Country List Settings. Note that the former FRG and the now 

reunified Germany are treated as two separate countries. 

BRD 

Bundes Republik 

Fed Rep Ger 

W Ger 

West Germany 

Former German Democratic Republic 

As a default the following variants are included under GDR. To treat them as separate, 

uncheck the GDR box in the Country List Settings. 
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DDR 

Deutsch Dem Rep 

E Ger 

East Germany 

Ger Dem Rep 

8.4 Version Changes 

This page records changes made in each release version of HistCite. 

Note that HistCite version numbers reflect the date of release. For example, version 7.10.1 

was released on October 1, 2007 (2007.10.1) 

Version 11.9.12 

    Web of Science compatibility upgrades 

    Added support for all versions of Web of Science exported text files 

    Local Citation Score (LCS) now compatible with cited reference export from all versions of 

Web of Science 

    Cited Reference search now works for all versions of Web of Science 

    Updates to HistCite Help file explaining how imported records are processed 

Version 9.8.24 

    Changes to Word list analysis  

    Author keywords and Web of Science KeyWords Plus® may be included in Word analysis. 

    New settings allow users to customize how multi-word terms and/or hyphenated words are 

analyzed and displayed. 

    In the record lists, some words (surrounded by unusual punctuation or white space) in titles 

were not properly identified with links. Bug fixed. 

    When updates to word lists were pending small words could have had an erroneous 

"Pending..." message.  Bug fixed. 

    Changes to Bibliometric View. 

     A new parameter, LCSx, is calculated in Bibliometric View. LCSx shows the Local Citation 

Score excluding author self citations for each record. 

     h-Index calculations, based on local citations (LCS), local citations excluding self citations 

(LCSx) and global citations (GCS) are now available for filtered lists of records. 

     Totals, means and quartiles for LCSx are added to the statistics. 

    Changes to Custom View to take advantage of introduction of LCSx. 

    Changes to presentation of statistics in all views.  

    Changes to the Edit tool to make editing easier.  

    When Move To tool is invoked it defaults to the named item in the current list (i.e., Author in 

Author list, Word in Word list, etc). 

    Previously entered data are now cached per each list. 

    After creation of new records, editing is disabled until the lists are updated. 

    Layout changes to account for introduction of Internet Explorer 8. 

    Changes to CSV export. 

Version 8.12.16 

    Web of Science import fixed to account for changes in address format. 
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    Full author names are processed to take advantage of changes in name format introduced in 

Web of Science. 

    Articles with numbers are now processed to take advantage of changes in record format 

introduced in Web of Science. 

    Web of Science article keywords are processed and saved. 

    New Custom View feature. 

    If the Browser window is closed by accident, attempting to start a second copy of HistCite 

will restart the Browser window and reconnect to the previous session. HistCite allows only a 

single instance to run at a time. 

    Large graphs are drawn faster. 

    GraphMaker graphs are preserved within one HistCite setting, even if Graph Maker is 

closed. 

    Record list export to CSV-format files. 

    Several internal changes to improve processing speed and program stability. 

    Minor cosmetic changes. 

Version 8.5.26 

Feature Changes  

    Record lists have been rearranged. All numeric value columns are moved to 

the right side.  

    A "Tip of the Day" feature has been added. Tips appear in a window on 

startup. Appropriate controls, menu item, and settings have been 

added????.  

    Hyphenated words in the Word Analysis list are broken into separate words 

rather than treated as a single word.  

    Font size can be changed from the Settings page. 

Minor changes and bug fixes  

    Document type is shown when mouse pointer hovers over record number in 

record lists.  

    Record details now always show blank fields. Only Reprint and E-mail fields 

were affected.  

    LCS(e/b) is shown in record details in Bibliometric mode.  

    When files with tags were added, Tags link did not show up. Bug fixed.  

    When a record title was changed a hover message 'Pending update' was 

shown over stopwords (normally no message or link). Bug Fixed.  

    When a new record was created in the Cited Reference list, navigation in the 

list was broken. Bug Fixed. 

    In Graph Maker, new default graph display size is 'window'. The right graph 

pane now has a separator bar for text pane (if Info or Legend is checked). This 

ensures that the first made graph would really fit into its window size. Checking 
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or Unchecking Info and/or Legend may still require redrawing of the graph to get 

the right 'window' size.  

    The graph list table includes an Information column.  

    When viewing saved graphs there are now additional 'Back' navigation links at 

the top and right under the image.  

    Improved "Add File" dialog.  

    Manual WoS 3 setup is removed from the Settings due to discontinuation of 

WoS 3. 

    Saving under a new file name gave erratic errors due to a security issue. Bug 

Fixed.  

    Latest WoS export downloads may include DOI data in Cited Reference lists. 

These are now correctly processed.  

    When Cited Reference lists contain DOI data there is a link to the DOI system.  

    DI tag (DOI) is processed from source records and stored and displayed in 

record details.  

    Occasionally, the program would abort without much notice. (The error 

message would be reported on the console window, which disappeared 

immediately.) Now, the error message is reported back to the user and logged 

without aborting the program.  

    When historiographs included records with LCS and GCS that were below set 

HTML limits, their full details were not included in the exported HTML output, 

resulting in broken links from the graphs. Now, such records are saved. 

 

Version 7.11.7 

    Added automatic searching of Web of Science from the Cited References page. 

    Changes to Settings page for compatibility with changes introduced in WoS search 

interface. 

 

Version 7.10.1 

    Initial release of HistCite 

9. Troubleshooting 

For Technical Support 

If you have questions about using our products or about your access to them, 

please visit our support page. This page has links to our support 

Knowledgebase, the local telephone numbers and hours of operation. When 

you click on the Open a Support Case tab, your issue will be immediately 

routed to your local support team. 

http://science.thomsonreuters.com/support/
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9.1 Windows Vista Issues 

If you are using Windows Vista operating system, you might have a problem starting HistCite, 

due to the security measures built into Vista.  

    If you get a CODE 42 error, right click on the HistCite.exe program and select "Run as 

Administrator". This will eliminate the error message and it should not occur the next time 

you start HistCite. 

    If the program fails to start entirely, you may have an issue with Vista's hardware Data 

Execution Prevention system. To avoid the problem, use the following steps: 

1.   Open the Vista Control Panel from the Start menu 

2.   Open "System" 

3.   Click on the "Advanced" tab  

4.   Click on the "Settings..." button under "Performance" 

5.   Click on the "Data Execution Prevention" tab  

6.   Select the radio button marked "Turn on DEP for essential Windows programs and services 

only" 

7.   Click out of the dialogs using "OK"  

9.2 "Fakepath" Error 

If you are using Internet Explorer Version 8, you might see an error message, such as File: 

"C:\fakepath\HistCiteSample.txt": No such file or directory", when you try to add a new file 

using the File -> Add... menu. This is due to some changes introduced in Internet Explorer 8. 

The work-around is as follows. 

    Double click the globe Internet icon at the bottom of your IE8 window 

    Click "Local intranet" 

    Click "Sites" 

    Click "Advanced" 

    Make sure http://127.0.0.1 is in the input field 

    Click "Add" 

    Click out of the dialogs with OK. 

It will now be possible to add files in HistCite as usual. 
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